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AllPlayers.com Overview 

Welcome to AllPlayers.com - the one stop web destination to Organize, Advertise, Register and Manage 

activities - all for FREE!  AllPlayers.com is a free all-inclusive website and portal that connects groups, 

organizations, leagues, group members, players, families, coaches and fans in one easy-to-use and 

convenient website. We have consolidated all of your activities including online registration, group 

management, communication, user profiles and organization/league management. AllPlayers.com takes 

the hassle out of activity management, group/league management and coaching. We help make 

communication with group members, players, families, volunteers and fans easy. This manual will help 

you to understand and navigate AllPlayers.com with ease. 

AllPlayers.com is easy and always free! 

Here are some highlights that you can browse quickly. After this, we can get right into the site – where 

the real fun is! 

For Players, Families and All Users 

 Create an account on the system for free  

 Can be anyone over 13 years old - under 13 may join but it must be a sub-account created by  a 

parent 

 Keeps family and fans organized with unified calendars for multi-sport and multi-child schedules 

 Ability to communicate with other players and families online 

 Matches skilled athletes with scholarships, colleges, camps and services (coming soon) 

 Great savings on apparel and gear 

 Track orders and registrations 

 Ability to find a group/organization by zip code 

 Request friendships with other users 

o Approve friendship requests  

 Photos 

o Create albums and upload photos to them to share with family, friends, those in your 

organization, group mates, or leagues 

o Highlight a face or person in a photo and associate that tag with a group or friend 

For Parents 

 Quick and easy online registration 

 Unified calendars for multi-sport or activity and multi-child schedules 
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 Control all aspects of an under-13 child’s account 

 Child Online Privacy and Protection Act (COPPA) compliant 

 Keeps parents engaged in the information that matters to them the most 

 Have the same friendship rights as their children in terms of permissions with group members 

and other group parents 

 Ability to view 

o Status updates 

o Photos 

o Profiles of group members  

o Profiles of other group parents 

 Ability to restrict child's data to . . . 

o Not be shared to other group-members 

o Only be available to the coach or group admin 

o Only be available to friendships parents have approved 

 (see the chapter Children) 

For Coaches 

 Removes paperwork from team organizing 

 Easy, online communication with players and parents to communicate rainouts, snack schedules 

and team activities 

 Populates and shares practice and game schedules with parents  

 Provides real-time player information, addresses, emails and phone numbers 

 Templates for coaches to use when communicating with parents, media and other associations 

 Online team registration and fee collection 

For Groups and Organizations  

 Takes the paperwork out of organizing and communicating 

 Groups, organizations, leagues, teams, coaches and parents are all online 

 Online registration, fee collection, apparel and gear procurement 

 Online maintenance for group schedules - one click to update  

 One click to email assistants, coaches, parents and players 

 Access to a real-time player and group database 

 Associations, organizations, and groups can communicate relevant camps, scholarship info and 

coaching materials with one-click 
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Getting Started 

Creating Your Account 

Once you navigate to AllPlayers.com site in your web browser, the first thing you are prompted to do is 

create an account. Registration is free and takes less than a minute to complete.  

To read our Children’s Privacy Policy, click on the COPPA Privacy Policy link. When you are ready, fill in 

your information on the home page and click Create new account. The math problem is not to test you. 

It is just there to make sure that you aren’t a web robot or machine! 
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Your account is now created and you are now ready to populate the rest of your profile whenever you 

are ready. This is documented in more detail in the chapter Setting Up Your Profile. 

In addition to the quick registration fields, there are other links on this page that you can access:  

 You can see the groups advertising within AllPlayers.com by clicking on the Search icon, and 

then refining your search using the various filters. To register, click the register now button and 

you will be prompted to sign in or create an account. 
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 Benefits To You-find out in detail, how AllPlayers.com will benefit you by clicking this tab at the 

top of the page. 

 How It Works-click on the tab at the top of the page to watch a video and see how 

Allplayers.com can help you organize, connect, and manage your group in three easy steps. 

 Watch a Video-click on the link to watch a video and find out what AllPlayers.com can do to 

simplify all of life’s events.  

 Who’s It For?-click the link to find out who the website can benefit. 

 Am I Safe?-click the link to read how AllPlayers.com places the security of your players first. 

 You can also read the details of Allplayers.com by clicking the following links at the bottom of 

each page: 

o About AllPlayers-click this link to read about AllPlayers.com in detail. 

o Company History-click this link to read about the AllPlayers.com history. 

o Core Values-click this link to learn about the three values at the heart of our company. 

o Become a Vendor-click this link to learn how to contact us and become a vendor. 

o Contact Us-Our customer support information. 

o User Manuel-explains in detail, how to navigate the site. 

o Join The Movement-Find your group and register. 

o Watch a Video-click to watch a short video about how AllPlayers.com can simplify all of 

life’s events.  

o Who’s It For-click and read about who the website can benefit. 

o Terms Of Use-these terms of Use apply to all websites owned and/or operated by the 

AllPlayers.com, Inc. 

o Privacy Policy - AllPlayers.com maintains the confidentiality, security, and integrity of 

information that we collect from all our members. Please read our policy online for 

more detailed information. 

o Shipping – this involves the delivery method and timing of transactions and purchases 

o Returns and Refunds - AllPlayers.com is committed to your complete satisfaction 

o Merchant Services & Fee Collection-join our merchant services team. 

Logging Back In 

The home page is also your main login page when you return to the site. On the top left, just enter your 

email address and password and click the Log in button. You can also create a new account by clicking 

the New Account link. 

If You Forget Your Password 

If you forget your password, click Forgot password. On the next page, enter your email address and 

answer the verification math question. Click E-mail new password button and you will be sent a link in 

email that allows you to click it for a one time access to the site in order to reset your password.  
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Navigating AllPlayers.com 

There are common elements that appear on most pages. Getting familiar with these will help you 

navigate the entire site. 

At the top left of most pages, you will see Welcome and links to: 

 Your login name – this takes you to a view of your profile  

 Log-out –logs you out of the system 

Feedback 

You are able to leave the AllPlayers.com customer service team feedback on any page in the site. Click 

the [+] Feedback link on the lower right side of every page to leave your feedback or comments. Type 

your message and click Send. We encourage you to send as much feedback as you want. Your comments 

really help us make improvements to our site. 

Required Fields 

Whenever you see an asterisk, you must fill in the information for that field in order to submit 

information on that page. You will not be able to proceed without doing this. This will probably be 

obvious because you will be reminded if it has not been filled in, but we wanted to warn you in advance. 

Main Navigation Bar 

The main navigation bar is the blue bar across the top of each page that shows the main sections of 

AllPlayers.com. Click on a header to go to that section (See the Main Navigation Bar Chapter for more 

details): 

 Profile-Clicking this header takes you to your personal profile. 

 Messages- From the dropdown menu, you can click on Sent (view your sent messages), 

Compose (Write a new private message to send), Inbox (view received messages), Broadcast 

(create a message to send out to multiple users/groups). 

 Calendar-Clicking this header will direct you to your personal calendar. 

 People- After clicking on People in the header, you have the option to show Friends (friends in 

the allplayers.com system), Group Mates (anyone in your group), and Find (allows you to find 

people). 

 Groups-Clicking this header allows you to find, create, or view groups. 
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 Search-You can see the groups advertising within AllPlayers.com by clicking on the Search icon, 

and then refining your search using the various filters.  

Navigation Conventions for this Manual 

Throughout this manual you will see the path to navigate as explained below. 

Profile>Edit>Change Password takes you to the section where you can change your privacy settings. 

To get to this page: 

 click Profile on the navigation bar 

 then click the Edit tab 

 then click Change password  

 

Throughout the rest of this manual, you will be directed to sections to navigate to using this convention 

– links separated by the “>” character.  

Panels 

Panels are components of a page. They are defined in this way because they may show up with the 

same functionality on different pages. Depending on the page and its context, you may or may not see 
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them. For example, you are not shown the Unpaid Registrations panel if you do not have any unpaid 

registrations. There are four panels on the page below:  

 Notifications 

 My Groups 

 My Children  

 Recent Activity 
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Setting Up Your Profile  

Now that you have an account, you can fill in the rest of your user profile. Your profile makes it possible 

to customize your AllPlayers.com site experience to fit your needs. What you select in this section 

determines how you want your Profile main page (Profile>View) to appear and function. 

The more complete you are in filling in all the fields, the more the system can help you as your 

information will be used as defaults throughout the site.  

Account 

(Profile>Edit>Account) 

Here’s what you can do in the account section of your profile: 

 Change your email address 

 Select a picture from your computer or icon from the list to display on your Profile page 

 Choose your default time zone  

 Indicate whether you want to keep your site activity from appearing in the activity pages 

 Indicate whether you want to receive email notifications when you receive new private 

messages 

Click Save to keep this information.  

Deleting Your Account 

(Profile>Edit>Account) 

Scroll down to the end of this page and click Delete. You may then choose from: 

 Disable the account and keep all content 

 Disable the account and un-publish all content  

 Delete the account and make all content belong to the Anonymous user 

 Delete the account and all content 

If you decide that you don’t want to delete your account, click Cancel. 

Change Password  

(Profile>Edit>Change password) 
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To change your current AllPlayers.com password, you can enter a new password here and click Change 

Password. 

Groups 

(Profile>Edit>Groups) 

Note: This function description will be added later. 

Site Preferences 

(Profile>Edit>Site Preferences) 

Settings 

Here you can choose to enable or disable social networking features. For example, if you are a parent, 

you may choose to disable the ability of your child to post messages that other people can see or the 

ability to upload pictures into albums. This is a preference and the default is set to Enabled. The settings 

include: 

 Send Messages - determines your ability to send messages to other users 

 Ticker Post - post messages to the ticker. The ticker is the message list posted on your home 
page 

 Friends - determines your ability to send and approve friend requests 

 Photo Albums - determines your ability to upload photos into albums 

Privacy 

Here you can decide the level of interaction you wish to have on the site by selecting one of the 

following: Friends, My Fans, Everyone or Nobody. 

 Friends – this includes only people who I have selected (from the list above) can see the people 

that I am friends with 

o A friend is someone that you know and knows you 

o To be friends with someone, both people must confirm the request 

o Fans are people who are supporters of a team, organization, league or player 

 Profile - only people who I have selected from the list above can see my profile page 

 Access Avatar - only people who I have selected from the list above can see my avatar or more 

commonly known as a profile picture.   

 Photo albums - only people who I have selected from the list above can see my photo albums 

Profile (personal information) 

(Profile>Edit>Profile) 
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Your name, gender and birthday are already shown from when you created the account or last edited it.  

 

You can fill in the following areas.  

 Personal  Information 

 Bio Data – for example height, gender, birthday, and shirt size 

 Emergency Contact Information 

 Emergency Address 

 Primary Address 

Underneath Emergency Address and above Primary Address, you can select who will be able to view the 

profile page of this account. Select Accessible by from the dropdown field to make your selection: 
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 Friends – people that you designate as your friends 

 Everybody – everybody on the AllPlayers.com site 

 Nobody – no one besides you can view your profile page 

When you are done, click Save.  

Sports Experience  

(Profile>Edit>Sports Experience) 

If you have sports experience, enter it here. Under Sports Experience, click Add sports experience.  

From the dropdown menus, make your selections: 

 Sport - select your sport 

 Skill level – indicate your skill level for your sport by clicking on the stars 

o Pick 1 if you’ve never played before and 10 if you are a pro 

 Years played 

 Seasons played 

 Enter Preferred Number 

 Enter Preferred Position 

When you are done, click Save. 

View Your Profile Summary 

(Profile>View) 

This is your public personal page as it is viewable to others. For example, if a friend clicks on your name, 

they will be directed to this page. It has many of the same elements as the Home page, but the look and 

layout is customizable based on your Profile settings.  

Elements of this page include (and are mostly duplicated in your home page after setup): 

 Your profile photo 

 Children 

 Friends 

 Group Mates 

 Photos 

 Status – you can type in 200 characters and click share. This is a home page status posting and 

depending upon your profile settings; this can show up in your friend’s Home page under the 

Recent Activity panel. 
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 Your Profile Panel – this allows for automatic listing of certain activity items, for example if you 

are a group manager and you make updates to a group, team, division, league, etc. a message 

will appear in this section indicating the update. 

o Comment – you can insert a comment to any item in this list by clicking the Comment 

link next to the ticker entry. 

o Delete activity record- you will see a little yellow x to the right of the comment link. 

Clicking the X deletes the activity comment. 

o Photos – if you have posted photos, they will appear in this section and enable you or 

others to make comments.  

 



- AllPlayers.com User Manual © 2010 
 

21  

 

Bills 

(Profile>Bills) 

Note: This function description will be added later. 

ID Verification 

(Profile>ID Verification) 

One of the ways AllPlayers.com creates a safe environment for children is to verify the identity of 

someone who registered as their parent.  Once verified through approved COPPA verification methods, 

the child account is release from “hold” status and the parent then has complete control over a child’s 

account. This approach prevents children under 13 from accessing the site, gives the parent governing 

rights over their children once verified, and prevents personal identifiable information from being 

posted without the parent’s verifiable consent.   

Invitations 

(Profile>Invitations) 

This is where you can invite other people to join AllPlayers.com. You can click on the following links for 

specific information. 

 Accepted - The invitations shown on this page have been used to join the site. Clicking on an 

email address takes you to the user's profile page.  

 Pending - The invitations shown on this page haven't been accepted yet. 

 Expired – The invitations shown on this page have not been used to register on the site within 

the expiration period of 30 days. 

 New invitation – you can send an email to others to join AllPlayers.com 
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Mobile Settings 

(Profile>Mobile Settings) 

Mobile Notifications are currently in Beta Testing. Access to this feature will arrive soon. 

Orders 

(Profile>Orders) 

This is where you can see the items that you have ordered, for example if you pay for a league 

registration. You can and sort the orders by date, order #, status, products and total amount by clicking 

in the respective column header. Clicking in the column header that is currently sorted will reverse the 

direction or the sorting. 
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Relationships 

(Profile>Relationships) 

If your parents have an AllPlayers.com account, they will show up here. You can click on their name to 

view their profile. Also, you can invite your other parent or guardian by clicking Invite your Parents. This 

enables you to send an email to invite them to the site.  

Requests 

(Profile>Requests) 

When someone on AllPlayers.com has requested that you become friends, you will see a request here.   

 To add the friend, click Confirm 

 See message “You are now friends with (person’s name)” 

 You can click on the person’s name to view their profile 

 To not add the person as a friend, click  Ignore 
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Home Page 

The Home page is the central place that shows the information that you want to see and have 

customized in your profile. You will see panels of information that are described below. Click on the 

AllPlayers.com symbol in the top left of the page to view the Home Page. 

Status Alerts 

Each time that you first login, you may see a small box pop up that says Status. This appears: 

 If you have unread messages 

 If your account has been updated 

 If you have a new friend request 

 For other times when AllPlayers.com or other people need to get in touch with you 
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In this picture, the alert shows how many unread messages you have. To read and respond to the 

messages, click on the corresponding link.  

 

Notifications Panel  

This panel will only show up if you have:  

 New message(s) and Friend request(s) - To read your messages, click the link to read the 

messages. This takes you to Inbox. To see who wants to be your friend, click # friend(s) request. 

This takes you to Profile>Requests. 

 Invitation(s) to join a group – by clicking on the link, you are agreeing to join the group. You are 

taken to the new group’s Home Page where you see a green status box saying “You are now a 

member of Example Group”. 

My Groups Panel 

This panel shows your group information.  
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This screen shot shows that the user is a member of twenty two groups (see the Groups chapter). 

 

Find a Group 

If you are not registered for a group, click the GROUPS tab at the top of the page, then click the FIND 

GROUPS button. Then you can search for a group by name, category, postal code, distance, and 

registration status 

Existing Group Member 

If you are already a member of a group, click on the group name displayed to see the group details. (see 

the Navigating Groups section) 

My Children Panel 

If you want to add a child click Add a child. This takes you to the add a child to my account page. You will 

see the list of children you have added. You may click one to view their profile. To see a complete 

description of adding an account for your child, see the chapter about Children. 
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Friends Panel 

This panel shows the people you’ve selected to be your friend. See the Friends chapter to find out more 

about how you can manage your friends. 

Respond to a Friend Request 

If someone has requested that you be their friend, you will see this on your home page, under the 

Notifications panel. Click the # friend request.  

This takes you to Profile>Requests. You can see who wants to be your friend along with a message. Click 

Confirm if you are ready to be this person’s friend or Ignore if you would rather not.  

 

Group Mates Panel 

This panel will only appear if you are a member of a group. Here you can see who else is in your group. 

You see their profile photo if they selected one next to the group mate’s name.  

 If you click the group mate’s name, you will go to their profile page.  
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 You can also click the People tab, then the Group Mates button.  This takes you to a new page 

where all of your group mates are listed. 

Photos Panel 

AllPlayers.com allows you to post pictures and arrange them into albums. This is a great way to share 

photos of teams, games, celebrations, kids or anything else you want your friends to see. See the Photos 

chapter to find out more about how you can manage your photos and albums. 

Find Your Group  

To find a group, click on the GROUPS tab at the top of the page, then click the FIND GROUPS button. This 

option is there to facilitate finding a group for you. You can find activities by entering as much or as little 

information you’d like to see from the list below and then click Apply: 

 Organization name 

 Category 

 Postal code 

 Distance 

 Registration status 

If you don’t see your group, you can also click CREATE GROUP to create your own group (see CREATE 

GROUP chapter for more details). 

Unpaid Registrations Panel 

Home Page Panel 

You are reminded to pay for group fees when they are unpaid and presented a way to pay now. This 

won’t be displayed if it does not apply. You can see registration information - person’s name, Group, Fee 

and Status. To pay, click Pay Now. 
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Shopping Cart 

You then see your Shopping Cart, with a Status message confirming the contents of the cart. You will 

see: 

 Remove – this removes products from your cart. Simply click the box next to the item you wish 

to remove and click Update cart. 

 Products – this shows the details of the items in your cart – (if you have children, their names 

can appear here for registrations) 

 Qty. – this is the quantity 

 Total – this is the total amount due per product 

Click Checkout to continue or Update cart 
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Checkout 

You are then taken to the checkout page where you can verify your order. You will see: 

 Cart Contents 

 Customer information 

 Billing information 

 Payment method – choose from Visa, Master Card, Discover and American Express 

 Order comments – if any 

Click Cancel or Review order 

Review order 

Your order is almost complete. You will see all your order information. If it all looks correct, click Submit 

order. You may click Back to make changes to your order if necessary. 
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Order complete 

Your order is complete! Your order number will be shown. You can view your current order status and 

order history by viewing your orders (Profile>Orders). You can click the link return to the front page to 

go to your Home page. 

Recent Activity Panel 

This shows the activity stream on your Home page. It allows you to see what people are doing right now 

and to see ticker entries and notifications from your friends regarding: 

 Status updates - such as new friends added 

 Image uploads from your friends photo albums 

 Updates of certain activity items - for example if you are a group manager and you make 

updates to a group, team, division, league, etc. a message will appear in this section indicating 

the update. 

You can comment on each ticker entry. Click Comment to show the box and to type your response. Click 

Comment to post the comment. If you click on your friend’s name you will be taken to their profile 

page. 

 Comment – you can insert a comment to any item in this list by clicking the Comment link next 

to the ticker entry. 

 Photos – if your friends have posted photos, they will appear in this section and enable you to 

make comments. 
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Calendar Panel 

After clicking the More link under the Calendar panel, you can filter what you would like to see on the 

calendar by selecting one of the fields under Category: 

 Game 

 Practice 

 Scrimmage 

 Meeting 

 Party 

 Other 

Notice the Calendar Legend which color codes each event type listed above for easy viewing. 

You can also filter the groups you would like to see on the calendar by selecting a group from under the 

Groups field.  

You can also get to your calendar by clicking the calendar heading at the top of the page. 

 

Main Navigation Bar 

The main navigation bar is the blue bar across the top of each page that shows the main sections of 

AllPlayers.com. Click on a header to go to that section. 

Search 

You can see the groups advertising within AllPlayers.com by clicking on the Search icon, and then 

refining your search using the various filters. To register for a group, click the register button and you 

will be prompted to fill out the necessary information. 

Profile 

Clicking this header takes you to your personal profile. 

Messages 

It is important to communicate with your teammates, other parents, your coach, etc. AllPlayers.com 

makes it easy to do this quickly and easily. You can read and write messages from many places 

throughout the system, but it’s always easy to choose Messages from the Home page. From the 

dropdown menu, you can click on Sent (view your sent messages), Compose (Write a new private 
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message to send), Inbox (view received messages), Broadcast (create a message to send out to multiple 

users/groups). If you are a group admin, you can broadcast a message by clicking on the Broadcast link 

next to the megaphone, on the group page. If you click Inbox Messages>Inbox, here’s what you will see 

something similar to: 

 

From here, you can: 

 Check your Inbox 

 View your Sent messages 

 See All of your messages 

 Write a new message 

Tagging Message(s) 

Tagging messages allow you to perform actions to multiple messages at the same time. This is a big 

time-saver. You will be able to: 

 Delete messages 

 Mark them as Read 
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 Mark them as Unread 

There are two ways to tag messages: 

 Click on the box to the left of the message to take it. If it is tagged, clicking it will un-tag it 

 Click on the box in the column heading to tag all of the messages on 

o Clicking it again will un-tag all of them 

Messages that are tagged will appear with a different color. 

Deleting Message(s) 

Once you have one or more messages tagged, you can delete them by clicking Delete. 

Changing the Status of Message(s) 

Once you have one or more messages tagged, you can change their status to Read or Unread. It may be 

helpful to change a read message back to unread if you don’t want to miss re-reading it later. It also may 

be helpful to mark an unread message read if you know what it is just from the subject line. 

Undoing a Tagged Action 

Once you have deleted or changed the read status of one or more messages, you have a chance to undo 

these actions by clicking the undone link in the small pop up box that appears. If you click undone, you 

will get a new message saying marked # threads as read/unread. 
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Writing a New Message 

Messages>Compose or Messages>Inbox>Write new message 

To write a new message: 

 click on the Write new message link 

 type the recipient’s name (this is required) 

 add a subject 

 write a message 

 click Send message to send 

 click Cancel if you have a change of heart and do not want to send it 

When you click Send, you will see an information alert saying that your message has been sent. 

Viewing Message(s) 

All of the first three tabs have the same functionality but show different messages.  

 The Inbox only shows incoming messages 

 Sent messages shows messages that you sent 
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 All messages show these two types combined. That way you can see the chronology of the 

threads. 

Here’s what you can see and do with messages: 

 If a message is unread, it will be bolded 

 You can read a message by clicking its subject (see Reading a Message) 

 You can see the profile of any participants listed in any message by clicking their name 

 You can sort by Subject or Last Updated by clicking on the appropriate heading 

 Clicking on the heading of a column that is already sorted will reverse the direction of the sort 

 You can tag messages to perform actions on one or more messages at once (see Tagging 

Messages) 

Reading a Message 

When you click the subject of a message, you will see a new link called Read message. After you read 

the message, you can: 

 See the name of the thread. In this example the thread is Après ski party 

 Click on any name in the message to view that person’s profile 

 Click Delete message to delete the message. You will be asked to confirm 

 Reply to the thread by filling in the Message section at the bottom of the page 

 Click Send message to send the message or click Clear to start over 
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Calendar 

Your calendar is a helpful tool to see all the events for the groups you are a member of. As an 

Administrator, you can add schedules and events.  

After clicking on the Calendar heading at the top of the page, you can filter what you would like to see 

on the calendar by selecting one of the fields under Category: 

 Game 

 Practice 

 Scrimmage 

 Meeting 

 Party 

 Other 

Notice the Calendar Legend which color codes each event type listed above for easy viewing. 

You can also filter the groups you would like to see on the calendar by selecting a group from under the 

Groups field.  

The screen shot shows the Month view. Each view lets you go to the previous or next time period  
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Month View 

In the month view you can: 

 See an entire month 

 See events in the appropriate day (just like a wall calendar) 

 Click on an event to pop up a window that shows the details of the event.  
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Exporting your Calendar 

Click on the calendar icon (lower right) exports the calendar as an .ics file (iCalendar standard format) 

and your browser will offer to help you open the file or save it on your computer. The window that pops 

up will have a different appearance depending on the web browser you are using but the functionality 

will be similar. 

People 

This section is an easy way to check out and communicate with people you know as well as a place to 

invite your friends to register with Allplayers.com. After clicking on People in the header, you have the 

option to show the following: 

 Friends – If you have connected to any friends in the allplayers.com system, you will see them listed 

here. This is the same functionality as clicking # friends or See All under the Friends panel on the 

Home page. If you don’t have friends, you can click on Profile>Find to begin a search for friends.  

o (see the section Managing your Friends) 

  Group mates - Here you can see who is on your group 

o If you are not in a group – you will see a message that you don’t have any group mates yet and 

that you when you join a group, you will automatically become group mates with those on that 

group 

o If you are in a group - You see their profile photo if they selected one next to the group mate’s 

name. If you click the group mate’s name, you will go to their profile page 

 Find - This allows you to find friends, add friends, see their profile picture, and send them a 

message. 

o See the section Finding Friends for more details 
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Groups  

Here’s why you are on AllPlayers.com in the first place. To play! The Groups sections have all the 

information you need to rest easy and put your energy into playing your sport. The best place to get 

started is from the Home page under Groups. 

You’ll need to join (or create) a group. From the Home page, you can find a group to register first then 

join. I hope you are getting the idea that navigating in AllPlayers.com is very flexible.   

Find a Group 

There are several places throughout the system where you can find a group. The easiest is from 

Groups>Find Group. On this page, you will see and can do the following: 

 Join and work with groups listed at the bottom of the page (see the section below) 

 Narrow your criteria for finding a group 

Filtering Groups 

Enter information in any or all of these fields then click Apply to see the filtered list of Groups: 

 Organization Name 

 Postal code – this will show Groups in this zip code 

 Distance – enter the radius from your chosen location 

 Choose miles or kilometers for this distance 

 Category – choose your category from the dropdown list 

 Registration status – you can choose from: 

o Open Registration 

o All Groups 
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You have the ability to create a new group by clicking the link under Groups>Create Group. You are not 

eligible to create a group if you are a child or acting on behalf of a child. You can see Create Group if you 

are not a child or acting on behalf of your child. If you have already created one or more groups, you will 

see list of the groups you manage. For more information, refer to the Group Administration chapter. 

Working with Groups 

Once you find the list of groups you want to work with you can: 

 Sort them by any of the underlined column headers – click on the currently-sorted column 

header to change the sort direction 

 To Register for a group, click Register-  see the Register for a Group section for more 

information 

 Click on the group name to View the Group 
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Register for a Group 

Confirmation 

Once you have found a group to register for (see Filtering Groups) and click Register, you will see a new 

Registration page (see picture) and be asked to Select a user to register. This shows eligible registrants 

from you and your children (if you have any). You will also be asked to select a Role to register. For 

example if you were registering for a team, the roles might be player or coach.   

The group administrator can choose what data to gather at the time of registration, it will vary by the 

group that you are registering for. 

Click Proceed to next step or Cancel. 
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Bio Data 

Next, you may be taken to a sports preference page where you can fill in optional information for this 

Group including: 

 Height 

 Weight 

 School 

 Grade 

 Shirt size 

 Hat size 

 Pant size 

 Shoe size 

 Position preference 

 Team preference - choose your preferred team or type it in if it’s not listed 

 Player skill 

 Seasons played 

 Years played 

Click Proceed to next step. You may also click Back or Cancel. 
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Contact Information 

Next you may be asked to provide contact and emergency information. 

 Primary address – this is required 

 Emergency contact info 

 Emergency address 

Click Finish. You may also click Back or Cancel.  
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Release Forms 

Finally, you may be asked to read and agree to the group’s General Liability Release. Click Finish to 

complete the registration process. For groups that require payment, you will see another screen for 

payment type and another to collect payment information. Depending on how the group was setup, you 

may be immediately place on your preferred team OR you may have to wait until the group manager 

places you on a team.  Please check the group page or contact the group manager for further 

information. You will then see a notification that your registration was successful and complete.  

View a Group  

There are many places throughout the system that allow you to view a group. The most straightforward 

is clicking on Groups>Find Group and selecting a group by clicking on it in the search results under the 

group header. Here’s what you will see: 

You will see three (or more) links on the top right of the page: 

 Pages 

 Calendar 

 Registration 

 There will be more if you are a group creator or administrator. See Group Administration Page 

for more information. 

You will also see tabs on the top left of the page: 

 Front  

 Schedule 

 Calendar 

 Photo Album 
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Pages Link 

If you click on the Pages link on the group’s page, this will take you to the group’s front or first page. 

This is the same as clicking on the Front tab on the upper left of the group page. You might see several 

panels on this page: 

 Group logo or picture 

 Registration Panel 

 Administrator Panel 

 Team record (if applicable) 
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 Groups Above Panel 

 Groups Below Panel 

 Guardians Panel 

 Members Panel 

 Images Panel 

 Group/Team Schedule Panel(if applicable) 

 Upcoming Events Panel 

 

Note: The position and appearance of the panels on a group’s page will differ because the group 

creator/administrator has the ability to customize the group’s page. 

Group Logo/Picture 

This is located in the upper left of the page and displays the group’s logo or picture 

Register Panel 

This panel displays where to register. Click the link to register for that group. 

Administrators Panel 

This panel displays the administrator. Click on a name to see their profile. This will also show whether 

this is a closed group or not. The group administrators may add (send invites) and remove members as 

needed. 

Team Record Panel (if applicable) 

This panel displays the group’s win/loss/tie record. For example, if the group is a team, then the team 

record would be displayed in the panel. 

Groups Above Panel 

If the group is associated with a larger group/organization, it will be listed here. You can click on the 

name to view the group page. 
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Groups Below Panel  

If the group/organization you are viewing is associated with a smaller group or subgroup, it will be listed 

here. You can click on the name to view the group page. 

After clicking on the group name, you can: 

 View group information 
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 Register for the group 

 Click on Calendar link to see the group calendar 

 Click on Schedule link to see the group schedule 

Guardian Panel 

This panel displays a list of guardians whose children are on the team. For each Guardian you will see 

the name of the guardian and the child that is a group member. Click on the guardians name to view 

their profile. The guardians may also be seen under the Members Panel. 

Group Members Panel 

This panel displays all the members of the group, which may include administrators, players, coaches, 

guardians, fans, volunteers, and any other designation that your Administrator has defined. For each 

person listed, you will see their profile photo and their name. Click either to go to their profile.  

Images Panel 

This panel shows all the images that have been tagged for this group. Click on any image to view it in 

more detail. 

Group/Team Schedule Panel (if applicable) 

This panel displays the group’s schedule. For example, if the group is a team, then the team schedule 

would be displayed. The panel would show you a chronological listing of the team’s games. For each 

game, you would see: 

 the name (description) of the game– click on this to see details for this game  

 the date and time 

 the groups – click on either group to View that Group 

 the result (if played) 
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Upcoming Events Panel 

If there are any upcoming events, this panel will be displayed. By clicking on the event link, you can view 

the details: 

 The description of the event, for example a game, practice, scrimmage, party 

 The date and time  

 Location 

 There is also a link to Flag as offensive, in case you find it so.  Items flagged as offensive will be 

investigated and offensive materials removed. 
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Group Calendar Link 

This link shows you a calendar similar to your individual calendar. It has all the views and navigation 

links. It differs in that it shows events for the whole group, instead of events from all of your groups (my 

calendar). See the Calendar chapter for more detailed information. 
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Registration Link 

This link will take you to the group’s registration page. Click this link to register for the group. See the 

Register for a Group section. 
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Schedule Tab 

In the upper left of the page is the group’s Schedule tab. Clicking on this tab displays the group’s 

schedule. For example, if the group is a team, then the team schedule would be displayed. There will be 

a Team Record panel on the left side of the page. The rest of the page would show a chronological listing 

of the team’s games. For each game, you would see: 

 the name (description) of the game– click on this to see details for this game  

 the date and time 

 the teams – click on either team to View that Team 

 the result (if played) 

 

Calendar Tab 

Clicking this tab will take you to a mini calendar or month view of the group’s calendar. This is different 

from the Group Calendar link, because it only shows the current month. You can still click on an event to 

see details. You will also see an Upcoming Events panel on the left side of the screen displaying the 

group’s upcoming events in a list format. 

Photo Album 

Clicking on this link will take you to the group’s photo album. The page will show all of the pictures that 

have been tagged to the group. To view a photo, simply click and a larger image will appear on the 

screen.  

Children 

You can add and manage your children's accounts. AllPlayers.com  is fully COPPA compliant which 

means we verify a parent’s identity and then they can control access to their child's account and what 

their child can and cannot do if they are under the age 13.  

Children Under 13 

Here are some features for children under 13: 

 They are blocked from creating an account (unless they lie about their age) 

o This prohibits them from registering for the correct league as most leagues do birth 

certificate verification 

 They are restricted in their actions based on parental settings that specify what they are allowed 

to do (see Account section) 

 Their personal information is protected from the public and shown only those relationships that 

the parent allows (see Site Preferences section) 

http://www.allplayers.com/
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 Their personal information is not searchable  

Parent Options 

Here are some features for parents: 

 Create your own account on the system 

 create parent-associated accounts for all your children 

 ID verification 

o ID verification (option on edit/profile) only display to parents 

o Status posting is removed when under 13 and parent verification has not occurred yet 

o (see ID Verification section) 

 Can act on behalf of your child on the system 

o Parent/Child control/act on behalf of only happens through age 13 of the child 

 Can edit your child’s information 

o Is copied on any messages where your child is a recipient or is the sender 

o Can set the privacy for your child on the system throughout the system 

 Can set who the child can access in terms of friends (nobody, friends, fans, 

everybody)  

 Can set who the child can access as fan of and see who is a fan of them  

 Can set who has access to the child’s friends  

 Can set who has access to the child’s profile  

 Can set who has access to the child’s image (avatar) 

 Can set who has access to the child’s photo albums 

o Can allow or not allow a child to: 

 View other profiles 

 Send friend requests  

 Message others 

 Upload photos 

 Change your profile avatar 

 Invite people 

 Able to approve other parents or guardians for your children so that both parents are able to 

have full parental rights for your children on the system 

o From the child's profile page select "relationship" then invite a parent or Guardian 

 Can find a group/league for a specific activity/sport in your area 

 Can register your children for a group which fits your requirements 

 Will automatically be associated as a parent for any group/ teams your children are on 

 Can see both your groups and your children’s groups (see Teams) 

 Will have all your events merged with child’s events on your calendar  
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Second Parent 

 Is able to gain parental rights for a child on the system through invite 

 Can request (or be invited) from the original (or 1st parent setup on the system) to be 

authorized as an additional parent for your children 

Separate parental ID verification would be required for each parent. 

Signing Up Your Child 

(Children>Add a child)  

For your convenience, you are able to add a child in several different places in the site. From the 

homepage or profile page, click the Add a child link under the My Children panel. A new window opens 

where you add your child’s:  

 Name 

 Birthday 

 Gender 

 Title 

 Email (this defaults to the parent’s email) 

 Password 

 Answer a simple math question 

 Click COPPA Privacy Policy to read what it entails 

 Click Create new account 

ID Verification 

(Profile>ID Verification) 

One of the ways AllPlayers.com creates a safe environment is to verify the identity of someone who 

registered as a parent.  Once verified through approved COPPA verification methods, the parent then 

has complete control over a child’s account. This approach gives the parent governing rights over your 

children and prevents personal identifiable information from being posted without the parent’s 

verifiable consent.  

Setting Up Your Child’s Profile 

(My Children panel>Add a child) 

Click on your child’s name under the My Children panel. This takes you to your child’s profile page 

where at the bottom left of the page under the User Control panel, click Act on behalf of this user.  
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At the bottom of the screen, you will see a notification bar indicating that you are now acting on behalf 

of your child and a link to switch back to your own account. 
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Next, go to Profile>Edit. Editing your child’s profile is similar to editing yours except that you won’t see 

the tabs for: 

 ID verification 

 Requests 

(See Setting Up Your Profile section for more)  

Viewing Your Child’s Profile 

Click on your child’s name under My Children or Friends on your Home page. You can also click on your 

child’s name on your Profile page - either under My Children or Friends. This takes you to your child’s 

profile page.  

Act On Behalf of This User 

At the bottom left of the child’s page, under User Control panel, you can click Act on behalf of this user 

in order to modify profile settings or to act on behalf of your child.  

You will see an alert that let you know that you are acting on behalf of your child. You are always able to 

switch back to your account by clicking the here link. 

 

When you do switch back to your account, you will see an information alert that you have switched back 

to your account. 
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Friends 

Friends are an important part of AllPlayers.com. You can access this functionality from many different 

places throughout the system. This functionality looks and feels the same regardless of where you 

access your friend information.  

You can always access your friends from the Home page. Click People>Friends (shown here). This 

displays your friends and allows you to do several things. 

 

Finding Friends 

To find friends, add friends, see your profile and send them a message, click People>Find on the main 

menu. 
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This takes you to a new page where you can enter search criteria. Just entering part of your friend’s 

name brings up a list of people registered in AllPlayers.com. To choose who you want to be your friends, 

you can click: 

 To select all the names on the list – click the column header checkbox (above all the other 

boxes) to add all the names you found 

 To select one or some of the names on the list – click the individual checkboxes next to the 

names you want 

Now, you are able to do two things: 

 To add friends: You can add click Add as Friend  

 To send a message: you can click Send Message 

o This takes you to a separate page where you enter a subject and a message and click 

either Send message or Cancel 
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Managing your Friends  

To see what you can do with your friends in the system, click People>Friends on the main menu. 

This takes you to a page with a list of your friends where you can: 

 Click on a friend’s name to go to your profile page 

 Remove a friend - To remove a friend, click Remove next to any friend (or child). This adds a 

panel at the top of the page that gives you one more chance to keep the friend. By clicking Yes, 

you will see a confirmation that your friend has been removed from your friend list. 

 Send a message to a friend - Click Send Message next to any friend (or child) to send them a 

message. (See Writing a new message section) 

 

Viewing a Friend’s (or Child’s) Profile 

If you have children, they will show up as a friend also. Clicking on your child’s name takes you to your 

profile page. See the Children chapter for more information and privacy matters. 
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By clicking a friend that is not your child, you are taken to your friend’s profile page. What you can see 

depends on the visibility settings your friend chose in their profile.  

 

 

 

Photos 

You can do many things with your pictures including: 

 Post pictures for your friends to see 

 Arrange them into albums 

 Tag groups for group mates to see 

This is a great way to share photos of groups, teams, games, celebrations, kids or anything else you want 

your friends to see. You can manage and view your photos from many places in AllPlayers.com but the 

easiest way is from the photos panel on the Home Page. 

Creating Your First Album 

In order to upload pictures to the site, just click the Home page link and scroll to the bottom (left) where 

you will see the photos panel.  

1. Click Create a Photo Album 

2. You are then asked to name the album. Give it a name and click Save 

3. Now you are ready to add photos 

4. You are now on the Create Image page 

Create Image 

You see the Create Image page, where you can see your album name and you can upload pictures from 

your computer. This page lets you add photos to this (current) album but is flexible enough to add 

photos to any of your albums. Here are the steps to upload a photo: 

 Verify your album name from the dropdown labeled Albums 

 Click the small green circle with a + sign in the middle 

 Select pictures from your computer to upload into the album 

 Click Save to upload a picture and save the image settings or Cancel All Uploads. 

o You will see a Status message confirming an image has been created 

 Click Next step. Notice the message that your picture file is in queue 
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 Edit Captions – Give your photo a name (this is required) 

 When you are finished, click Done Editing 

o You will see a Status messages confirming all images have been saved and published. 

You have the option to add and upload additional pictures 

 Note: You also have the option to switch to classic upload mode by clicking the link at the 

bottom of the section - Switch to classic upload mode 

o This allows you to upload one picture at a time 

o The default setting is regular multi-upload mode 

 

 

Viewing Your Albums 

Even though there are many places to view your photos throughout the system, the easiest is from the 

Photos panel on your Home page. 

You can see several of your albums in the Photos panel. To see all of them and have access to more 

functionality for your albums, click on the # albums link or See All.  
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Once you are viewing your albums, you may add another album by clicking Create a Photo Album. For 

each album, you may edit or view the album by clicking on Edit Album or View Album. You may also 

view the album by clicking on the photo associated with it. 

Viewing One Album  

Once you have created an album, you can view and edit it. You will see all your albums in the photos 
panel on the Home page. Click on one of the albums – either the associated picture or its name - to view 

the album. Or you click on the # albums link or See All. Select your album and then click View.  

You will now see the album. You can:  

• Click Back to Photos to see all of your albums 

• Click Add More Photos 

• Click any of the photos to View the Photo 

Organizing Photos in an Album 

Once you are viewing an album (see the previous section), you may click on the Organize Photos tab. 

Once there, simply drag the photos around to put them in the order that you would like. Click Save 

Changes to save the new order. 

Editing an Album 

You can see your albums in the Photos panel. To see all of them and have access to more functionality 

for your albums, click on # albums or See All.  

Once you are viewing you albums, click Edit Album to change its name. Click Save or Delete. 

Adding Photos to an Album 

Start by clicking the album name. Then, click Add More Photos. You are always given the chance to add 

photos once you create the album, but you can also add them when viewing an album. This takes you to 

the Create Image section. 

Now you are ready to add photos or create more albums. 

Viewing a Photo 

Once you are Viewing an Album, click on any photo to view it. It will probably be larger than the 

thumbnail preview. When you are finished viewing the picture, you may: 

 Go Back to the Album that contains this picture 
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 Click Previous or Next to see other pictures in this album 

 Click Edit Photo to change the photo or its attributes. See the next section for more details 
editing a photo 

 Click on the photo to tag a friend. A Friend’s box appears over the photo and you can type in 
your name. Click Ok to save it or Cancel. You can see this information at the bottom left of the 
page 

 See all people and groups who are flagged in this photo - shown in the bottom left corner 

 Click Flag as inappropriate – this link enables you to flag an inappropriate picture 

Editing a Photo 

Once you are viewing a photo (see the previous section), click Edit Photo. From here, you may: 

 Go back to viewing the picture by choosing the View tab 

 Change the album it is attached to - just pick an album from the Album dropdown  

 Change the photo Title 

 Add Group Tags so that this photo may be viewed from that group’s page 

o You may add additional groups if the picture already has tagged teams 

 Remove tags by clicking Remove next to the tagged group 

 Change the picture or replace it with a touched up version, etc.  

o Click Browse and find the new picture on your computer 

 Select the Rebuild Derivative Photos box in order to regenerate the thumb nail or various sizes 
images from the originally uploaded photo 

 Click Save to save all of your changes 

 Click Delete to remove this picture from the album 

o If you do, you will be asked to confirm as the delete cannot be undone 

Deleting a Photo 

Start by editing the photo (see the previous section). Then click the Delete button at the bottom of the 

page. When you do, you will be asked to confirm as the delete cannot be undone.
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Administration 

This chapter and the remaining chapters help you create and organize the activities that the 

players/group mates will do.  Start by creating a league. From there, you can link an association. Then 

you can continue to create a division and finally teams within that division. Here’s an example hierarchy: 

 League 1 

o Administrator(s) 

o Association (non-exclusive) 

o Division 1 

 Team 1 

 Coach 

 Other roles 

 Players 

o Player 1 

o Player 2 

o … 

o Player n 

 Team 2 

 … 

 Team n 

o Division 2 

 Team 1 

 … 

o … 

o Division n 

 League 2 

o … 

Information at a glance 

Features 

 Online and accessible 24/7 

 One-click communication to coaches, players and parents 

 Accurate and real-time data retrieval 

 Group/Leagues have access to the AllPlayers.com co-op for uniforms. Trophies, gear, 

background checks, and insurance procurement.  Allplayers.com extensive vendor network uses 
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competition to drive price down while providing the best value, service, and selection in the 

industry!  Allplayers.com can meet or beat almost any deal! 

 Communicate and promote group/league information about camps, league services and 

happenings to players and coaches through email, news feed, and webpage updates 

 Can create any groups, leagues, divisions and classifications within the system  

 

Competitive advantages 

 Free 

 Can be used as a facility management tool 

 Removes paper from the league organizing and management process 

 Online registration for teams and players 

 Online fee collection 

 Easy to track new players through team registrations 

 Up-to-date database of player information 

 Players and coaches can find a league by zip code 

 One click order placement and procurement! 

 

Benefits 

 Can create smaller groups, league divisions, and classifications within the system 

 Can reach out to potential group/league members through fan pages, news feeds, and website 

updates 

 Ability to invite additional non-users to the system  

 Easy to track new players, group members, team (including friends of the league), officials, 

facility managers, and other volunteers. 

 Unlimited photo storage 

 Fully COPPA (Child Online Privacy and Protection Act) compliant 
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Division Administration 

Features at a Glance 

Here are some division features for League Admins: 

 Create divisions 

 Have full rights for items below the league level (division, team, etc.)  

o This implies they always have same rights as Team Admin or coach, etc. 

 League Admins can create teams within each division 

o They are the owner and have full permissions for the team 

o League Admins can add system users that have registered for that division as players on a 

team in that division 

 They will only be able to add as a player those that are registered and eligible for 

the division 

o Adding a child to a team causes the parent to be added to the team as a parent 

o They can add any user that is over 13 onto a team as a coach or assistant coach  

o League admin can manage roles on the team 

 Such as make a parent the coach or assistant coach or volunteer 

 They can only select players from users that are registered in the correct division 

o Can create games for teams in the system 

o Can broadcast messages to various members of the league  

 Divisions can have various requirements for players such as:  

o Age minimum and maximum by a certain date (not required, but enforced if specified)  

o Gender (required) and can be male, female, or coed (enforced for players) 

o Maximum number of players, event player number, and event member minimum (not 

required)  
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o Seasonal information includes optional information that is enforced if specified  

o Registration start and end dates  

o Season start and end dates  

o Registration Fee for players  

Coaches 

Features at a Glance 

Here is an easy way to update players and other team members regarding: 

 Game schedules 

 Game changes 

 Snack schedules 

What coaches can do: 

 Create/design an official team page to organize and promote the team 

 Schedule games with teams not on the site  

 Create and share schedules, information and real-time updates with parents and players 

o Schedule events for the team such as practice, scrimmage, exhibition, meeting, party, etc. 

that will show up on the calendar for all persons associated with the team.  

 Broadcast a message to specific or all members of a team  

 Perform parent id verification if the league has been approved for id verification  

 Invite additional non-users to the system including friends of the team, officials, media outlets 

and other coaches 

o Collect registration fees for teams and players 

 Communicate with league administrators 

 Have access to valuable association training and coaching materials 
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How to be designated as a coach: 

 A coach can be invited to a team. He can respond to the link in that email, create an account and 

then accept a request to be put onto that team  

 A League Admin can target an invite for a coach for a specific team where they are automatically 

setup as coach when an account is setup 

 Alternatively, a coach can create an account – then a League admin could place them on the 

team and set them as the coach of the team  

 

Team Administration 

Features at a Glance 

Team Admins have the ability to manage the team accounts. League Admins can do everything Team 

Admins can do. 

 Team Admins have ability to edit the team page and set team-name, logo, mascot, team colors 

 Team colors are shown on the headings and dropdowns on the team page 

 Team Admins can select Manage Groups from the team page 

o May select which role team members are part of (i.e. admin, coach, player, custom)  

o New roles can be created 

 Team Admins can broadcast to any of the various personnel in a role  

o Can broadcast to all team members, coach members, player members, parent 

members, admin members or any combinations of the role that exist 

 Can invite people to be coaches, admins or any other role  

o If an invitee is not in the system, they will get an email with a link to create account  

o If registered (or once they register), they will have a request to join 
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Group Administration 

Now the fun begins! Follow along in this and the remaining chapters to create all you need for a robust 

group  filled with divisions, teams, players, fans, volunteers, and much more. 

Create a Group 

Only the official group administrator can create a group, as it is a required field. To create a group, go to 

Groups and click Create Group. Fill in the following fields:  

 Group name 

 Group Description – optional 

 Location-Address 

 Group Category 

 Group Type 

 Features – choose whether to enable the group calendar and/or registration 

 Settings 

o Private-hide your group’s content from non members 

o Active-decide whether the group is active or inactive 

o Fee (Approval Required)-Receive payments for registration fees 

o Group Mates-This feature enables all members of this group to automatically become 

group mates.  This will allow them to see each other’s profiles and message each other 

o Select the groups above your group 

 Additional Options – Choose two colors for your groups page and upload a group logo/image 
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Click Create Group. 

Now you have created a group and you will see your new group page.  
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Group Administration Page 

Links 

Once you get to the newly created group page, you will see several links across the top of the page: 

 Pages – this takes you back to the Group Administration Page or Front Page when you are on 

other pages. You can also get to the Front Page by clicking the Front link in the top left below 

the AllPlayers.com symbol.  

 You can add a page by clicking on the Add Page link. You will then be asked to add a 

label for the new page. After filling out the label field, click Save Configuration and the 

new page will be added to the Group’s profile.  

 You can also reset your pages to the original format by clicking Add Page link then the 

Reset To Defaults link. 

 Calendar – this shows you the main calendar section that filters events for this group. (see 

Calendar section). There are many different links/options when designing or editing your 

group’s calendar. 

 Add Event-In the top right, next to the question mark, click on the Add Event link. You 

will then be asked to fill out the event title, start/end date, event category (practice, 

meeting, party, etc.), Body (write a message), the audience (who will see the event), 

resource. Then you will click the Save button to continue to a screen where you can 

view your newly created event. You can still edit the event from this screen by clicking 

the Edit link. 

 Calendar-In the top left corner, under the AllPlayers symbol. This link takes you to the 

group’s calendar view. 

 List- Beside the calendar link. By clicking this link you are taken to a page that displays 

the group’s upcoming events in a list format. 

 Resources-This displays the group’s resources in a calendar view 

 iCal Feeds- iCalendar (iCal) format is a standard for calendar data exchange. iCal Feed enables 

an application to publish Date and Time based data to an external calendar application via the 

iCal standard.  By subscribing to iCal feeds you can view the up-to-date status of your calendaring 

and scheduling information. 

 Registration – By clicking on this link you can view and manage your group’s registration. If you 

have not configured your group’s registration, then click the configure your settings link. You will 

then be asked to fill in the registration requirement fields registration fees, subgroups, group 

registration, profile fields, (you will also decide the requirements for a player, coach, volunteer, 

fan, manager). Click Save Configuration when you are done. You can also reset your registration 

to the original format by clicking the Reset To Defaults link. 

 Manage Tab –Located in the upper right, beside the briefcase. In the dropdown menu there are 

several links: 

 Broadcast Message-By clicking this link you can send a message to all or select members 

of the group. You just select who you want to send the broadcast to (everyone, admin, 

guardian, coach, player, volunteer, fan, manager), enter a subject, enter a message, and 
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click Send Message when done. You can also broadcast a message clicking the Broadcast 

link next to the megaphone on the group page. 

 Schedules-Clicking this link will take you to a page where you can view the group’s 

schedules. If you have not made a group schedule, then click on the Create New 

Schedule link and build a schedule for your group. 

 Create File Upload-Click this link will take you to a page to create a new file upload. Give 

the file a Title, Choose File, select the Audience, Privacy setting, and click Save when 

done. 

 Members-Clicking this link allows you to manage, add, or remove the roles of your 

group members. 

 Bills-Clicking this link allows you to view your group’s bill 

 Create Event-You can click on this link to add a new event to the calendar (you can also 

do this by clicking the Calendar tab, then Add Event). You will then be asked to fill out 

the event title, start/end date, event category (practice, meeting, party, etc.), Body 

(write a message), the audience (who will see the event), resource. Then you will click 

the Save button to continue to a screen where you can view your newly created event. 

You can still edit the event from this screen by clicking the Edit link. When you add an 

event, it shows up on the group calendar as well as under the Upcoming Events panel 

on the group page. 

 Create Resource-Clicking on this link will enable you to create a resource or location. For 

example, a field or gym. You will fill out the required fields. When done, click save to 

view your new resource. You can still edit the event from this screen by clicking the Edit 

link. 

 Assign Groups Below-This link allows you to add and/or remove users from the groups 

below 

 Create Group Below-Clicking this link allows you to create a subgroup (group below) of 

your group. After clicking on the link fill out the group information, location, categories, 

features, settings, and additional options fields. Click Create Group to finish. 

 Settings Tab-Located in the upper right, beside the Manage tab. In the dropdown menu there 

are several links: 

 Group Settings-This link allows you to view and edit the group’s information, location, 

category information, settings, and additional option. Click save to finish. You can also 

delete the group by clicking the Delete button. 

 Customize Features-This link allows you to view and edit your features, like Auto 

Schedule Events, Calendar, Pages, Registration, and Default front page. Click Save 

configuration to finish. You can also reset you features to the original format by clicking 

the Reset to Defaults link. 

 Roles-This link allows you to either add a new role or edit previous ones. 

 Registration-This link allows you to view your registration settings. You can adjust the 

requirement fields, registration fees, subgroups, group registration, profile fields, (you 

will also decide the requirements for a player, coach, volunteer, fan, manager). Click 



- AllPlayers.com User Manual © 2010 
 

79  

 

Save Configuration when you are done. You can also reset your registration to the 

original format by clicking the Reset To Defaults link. 

 Customize Tab-Clicking this tab allows you to customize the group’s page. You can choose the 

page layout, as well as the panels that appear on the page. When choosing the panels, just 

choose a category from the dropdown menu and drag the panel where you want on the page. 

The categories are as follows: 

 Boxes 

 Calendar 

 File Uploads 

 Group Info 

 Members 

 Subgroups 

 Click save changes or Cancel (does not save customization) to finish. 



- AllPlayers.com User Manual © 2010 
 

80  

 

 

Panels 

In addition to the Group logo or picture, you will see the Group address underneath with a link to 

Google Maps that you can click to see where it is. 

 You will also see several panels on this page: 

 Group Panel – This panel will display the group name. You can click on the Invite link to send 

invitations, to other people to join your group as a player, coach, fan, volunteer, manager, etc. 

 Registration Panel – Click on the link to view and manage your group’s registration. If you have 

not configured your group’s registration, then click the configure your settings link.  
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 Group Record Panel-This panel will display the group’s win/loss/tie record. For example, if the 

group is a team, then the team record would be displayed in the panel. 

 Guardians Panel- this panel will display a list of guardians whose children are on the team. 

 Groups Above Panel- If the group is associated with a larger group/organization, it will be 

displayed in this panel. 

 Schedule Panel (if applicable)-This panel will display the group’s schedule. 

 

Invite 

This is where you invite users to join the group. Click on the Invite link under the Group Panel. This will 

take you to a screen where you fill out the required fields (the role for which the user will be added, 

email, message) and click send Invite when done. 
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Schedule 

This tab shows you a chronological listing of the team’s games. For each game, you will see: 

 The event– shows the two teams involved in the game. Click on this to see details for this game, 

enter game results, and view team profiles.   

 the event category- the category 

 the start date/time- when the event starts 

 the end date/time-when the event ends 

 Resource-the location where the event will take place. For example a field or gym. Click on this 

to for more details. 
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Add a Game 

Click Add a Game under the Coach Panel. 

 Enter your “Event Name” 

 Teams - select the participating teams: 

o Teams in the league 

o Other – enter another team, even if not on the site 

 this allows the game to be scored and be part of the team's schedule 

automatically 

 once entered the "other" team will become part of the coach's teams they may 

select for future games 

 this will place on your current team's calendar (for the coach), but will not place 

on other team's calendar unless in same division 

 Date and Time - When you click Date and Time, you see a popup calendar to click on the day. 

 Repeat - By clicking on Repeat, you see the section expand so you can add more specifics to: 

o Frequency - this dropdown allows you to choose Every 2, 3, 4… 

o Period - allows you to choose Days, weeks, months or years 

o Until 

o Advanced (click to expand section) 

 Month 

 Day of month 

 Day of week 

o Except (click to expand section) 

 Dates to omit from the list 

o Duration in minutes 

 Competitive – choose whether the game is: 
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o Just for fun 

o Competitive 

o Professional 

 Location 

Click Save to record these changes. 
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Add Game Results 

When a game is played, the Add Game Results page will be displayed. You can add the game results for 

each team and click Save. Once you do, you will see this reflected under the Team Record Panel. 
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When you add an event, it shows up on the Team calendar as well as under the Upcoming panel on the 

Team page. 
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Enjoy your experience with and on AllPlayers.com! 

 


